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Ques. 1. What all are the areas where gener-
ally student lack and should focus upon?
Ans: The student generally lack knowledge of
industry and its best practices, rules & regula-
tions that are issued from time to time by regu-
latory bodies. Finance students should try &
analyze the real time date from the annual re-
ports published by the companies & various
guidelines issued by RBI, The Institute of Char-
tered Accountants, SEBI, Department of com-
pany affairs etc. World News related to finan-
cial sector must be read regularly.

Ques. 2. How would you describe the picture
across the region in terms of the global fi-
nancial crisis?

Ans: The Global financial crises engulf most of
the world economies particularly countries
where there was a serious mismatch in ex-
penditure & revenue. Countries like Spain,
Italy, Portugal were under serious debt cri-
ses. There is a major focus on expenditure con-
trol by economies. The current crises seems to
be over and most of the economies have started
performing better by the intervention of their
Central Banks who pushed liquidity in the sys-
tem.

Ques. 3. What are the skills a finance special-
ized student should have?

Ans: Finance student must have following skills
a) Feel for the accounting numbers

b) Accounting knowledge

c¢) Ability to apply tools available for financial
analysis.

d) Analytical skills.

e) Availability of financial data of best compa-
nies in the industry for bench marking.

Ques. 4. Have sovereign funds and the bank-
ing sector been adversely impacted by the
global economic downturn in recent months?

HAVELLS

Ans: Sovereign funds and banking sec-
tor were seriously impacted by global
economic downturn. There was signifi-
cant increase in loan repayment default
rate. Industry as well as consumer, par-
ticularly, in realty sector default-
ed. Increase in default in loan repay-
ment increased NPA of banking sector.

Ques. 5. What are your views regard-
ing managing finance during crisis ?
Ans: Managing finance during crises is
the most challenging job. Person han-
dling finance has to be very cool headed
and besides prudence need to focus on
following :

a) Current Assets reduction

b) Dispose off unproductive assets
(Fixed)

¢) Conserve Cash and capital expendi-
ture may be deferred only when it is nec-
essary

d) Encourage cash sales and reduce cred-
it sales by offering cash discount.

¢) Negotiate hard on procurement cost
and bargain for maximum credit

f) Control administrative expenses / trav-
elling expenses etc.

g) Recruitment needs to be very selec-
tive.



: TIPS FOR ACHIEVING
I ENTERPRENEURTIAL SUCCESS

L ________

1. Unplug. The wired world connects us in
wonderful and unimaginable ways, but there’s a
lot of to be said for the real world. You have to
learn to let go. Set aside the phone and laptop
and carve out quality time with the people who
really matter to you. At the end of the day, they
are the only definition of what’s real. Time is
actually our greatest virtue. Cherish each of

these real moments.

3. Give back. There's a quirky bumper sticker
that asks people to "practice random acts of

kindness." And there’s some truth to this life
lesson, as long as it comes from the heart. It re-
minds you of the blessings you have and what
you should be grateful for, including all the
basic things we take for granted. It also allows
you to contribute to something greater than
yourself. Whatever you believe in -- a higher
power, the law of attraction or just karma -- this
will further fuel your success.

4. Don't overthink things. It's alright not to
know all the answers. The answers will come to
you when you least expect them. Trust your gut.
We are complicated creatures. That inexplicable
feeling you get sometimes tends to be right fair-
ly often. Try not to overanalyze it. Some myste-
rious Inner You is trying to help out by pointing
you in the right direction. Remember that time
heals almost everything. Give it time. If we
summarize this lesson in three simple words,
Life Goes On.

5. Be grateful for what you have. The only
person in charge of your happiness is you. You

don't own all the problems in the world. Count
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your blessings, not your problems. Be grateful,
because if you’re reading this, you're already
way ahead of billions others in this world. It
doesn’t matter if the glass is half empty or half
full; the only thing that matters is that you
have a glass and you're responsible for what
you pour into it. On the other hand, don't com-
pare your life to others and don't judge them.
You have no idea what their journey is all
about. So when things go wrong, just take a
deep breath and remind yourself of your great-
er purpose. Purpose isn’t defined by what you
want to achieve, but what you want to live for
to achieve happiness. It also eliminates all
fears. And, if you live a life with purpose,
you’ll never be bored.

6. Relationships are everything in life. You
can always improve your connection to your
loved ones. They teach us to become better
people, to become the best possible version of
ourselves and remind us what’s worth fighting
for. They are also our biggest fans during our

ups and supporters during our down moments.

7. Make piece with your past. Don't let it dis-
turb your present. Own your mistakes. At the
end of the day, every decision you make, even
the bad ones, are your responsibility. Nobody
wins when you start looking for someone to
blame, so stop looking and keep moving. For-
ward movement is the key. You will have bad
days and more than your fair share of failures.
But, it’s really about getting back on your feet,
dusting yourself off, and getting on with this
business of living. That’s the Big Secret of
Life. You fall down, you get up.

FINJOB
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Aptitude Test

e

Are you ready?

1. A man buys Rs. 20 shares paying 9% dividend. The man 3. A 6% stock yields 8%. The market value of the stock-
wants to have an interest of 12% on his money. The market val- is:

, APTI-TRICKS

ue of each share is:

A.Rs. 12 B. Rs, 15

C.Rs. 18 D.Rs, 21

Explanation:

. 9
Dividend on Rs. 20 = Rs. [100 e 20] = Rs.

| o

Rs. 12 is an income on Rs. 100.

" Rs. = isani Rs. |22 5 2| —ks. 15
. S. 5 IS an income on Rs. 12 }(5 = hS. .

2

2. By investing in 16 3 % stock at 64, one earns Rs. 1500. The
investment made is:

A. Rs. 5640 B. Rs, 5760

C. Rs. 7500 D. Rs. 9600

Explanation:

To earn Rs. 53—0, investment = Rs. 64,

. 3
To earn Rs. 1500, investment = Rs. [64 X E X 1500} = Rs. 5760.

I. The main components or elements of the

...................... , expenses, gains, and losses.
2. Prepaid insurance is reported as an
3. Theword" .................... '
.......................... during the specified time interval.

5. The first section of the statement of cash flows is the

FREQUENTLY ASKED QUESTIONS

income

.................. on a company's balance sheet.
" is often in the title of liability accounts.
4. The statement of cash flows explains the changes in cash and cash

............... activities.

A. Rs. 48
C.Rs. 96

B. Rs. 75
D. Rs. 133.33

Explanation:

For an income of Rs. 8, investment = Rs. 100.

. . 100
For an income of Rs. 6, investment = Rs. [— X GJ = Rs. 75.

. Market value of Rs. 100 stock = Rs. 75.

4. Rs. 9800 are invested partly in 9% stock at 75 and
10% stock at 80 to have equal amount of incomes. The
investment in 9% stock is:

A. Rs. 4800
C. Rs. 5400

B. Rs. 5000
D. Rs. 5600

Explanation:

Let the investment in 9% stock be Rs. x.

Then, investment in 10% stock = Rs. (9800 - x).

10
— ¥ (9800 - x)
B0

9800 - x
8

= 24x =9800x 25 - 25x
= 49x = 9800 x 25

— x = 5000,

statement are




' EXCEL WITH MS-EXCEL

~ 7.J| Excel 2010
4% = Working with Charts

Introduction
A chart is a tool you can use in Excel to communicate your data graphically.
Charts allow your audience to see the meaning behind the numbers, and they
make showing comparisons and trends a lot easier. In this lesson, you will
learn how to insert charts and modify them so that they communicate
information effectively.
Charts
Excel workbooks can contain a lot of data, and that data can ) ) ) )
often be difficult to interpret. For example, where are the Video: Working with Charts in
highest and lowest values? Are the numbers increasing or Excel 2010

decreasing?

The answers to questions like these can become much clearer —cuumn Hos Fle
when the data is represented as a chart. Excel has many
different types of charts, so you can choose one that most
effectively represents the data.

To Create a Chart:

1. Select the cells that you want to chart, including the column titles and the row labels. These cells will be the
source data for the chart.

Watch the video (4:31). Need help?

1

2 |Young Adult $35,358.00 $42,685.00 $20,893.00 $16,065.00 $21,388.00
3 |Classics $18,580.00 $49,225.00 $16,326.00 $10,017.00 $26,134.00
a |Mystery $78,970.00 $82,262.00 $48,640.00 $49,985.00 $73,428.00
5 |Romance $94,236.00 $131,390.00 $79,022.00 $71,009.00 $81,474.00
6 |Sci-Fi & Fantasy $16,730.00 $19,730.00 $12,109.00 $11,355.00 $17,686,A0
7

Selecting cells

2. Click the Insert tab.

3. Inthe Charts group, select the desired chart category (Column, for example).

Insert Page Layout

B ke Dl O

Formulas Data Review View Design

Picture  Clip .. Column Line Pie Ear Area  Scatter Other
Art @zt Screenshot - - - - - - - Charts ~
Ilustrations [k Charts ]

- fl’| Genre | Column
B Insert a column chart. G
- 2006 A 2007

Column charts are used to compare -
535,358.00 542,635_[]1 values across categories. .00

Selecting the Column category

- 5 o o o
o..oon..'oooo.oo--
.

FINJOB



ISSUE-18th

|
:_ EXCEL WITH MS-EXCEL

4 Select the desired chart type from the drop-down menu (Clustered Column, for example).

I T

Insert Page Layout Formulas Data Review View Design

| HE L[y shapes © ﬁh }»&, e = ~ ..)

i’ e

& T2 smartart

Picture  Clip ... Column| Line Pie Ear Area  Scatter Other
Art [t Screenshot = - - - - - *  Charts =
Tllustrations 2-D Column ]

- F | Genre

R M e
= 2006 Ry 2007 R 3-0 Clustered Column
$35,358.00 $42,685.0(
$18,580.00 $49,225.0(
$78,970.00 $82,262.0(
$94,236.00 5131,390.00 O
sy $16,730.00 $19,730.0C J‘

Compare values across categories
by using vertical rectangles.

Use it when the order of categories
is not important or for displaying
item counts such as a histogram.

ag ) A O

Selecting a chart type

5. The chart will appear in the worksheet.

A B C D E F G

il Genre H] | 2007 B4 2008 B 2009 K3

2 Classics $18,580.00 $49,225.00 $16,326.00 $10,017.00 $26,134.00

3 Mystery $78,970.00 $82,262.00 548,640.00 549,985.00 $73,428.00

4 Romance $94,236.00 $131,390.00 $79,022.00 $71,009.00 $81,474.00

5 Sci-Fi & Fantasy $16,730.00 $19,730.00 512,109.00 $11,355.00 $17,686.00

& Young Adult _535,358.00 542,685.00 $20,893.00 516,065.00 521,383.00_

7 F =]

$140,000.00

8

3 $120,000.00

10

11 $100,000.00 M Classics

12 $80,000.00 - Mystery

13

B Romance
a $60,000.00 -
M Sci-Fi & Fantasy

15 $40,000.00

16 M young Adult
= $20,000.00 -
18 $0.00
19 2006 2007 2008 2009 2010
20 | |

The new chart

Chart Tools -

Once you insert a chart, a set of Chart Tools, arranged into three tabs, will appear on the Ribban. These are only
visible when the chart is selected. You can use these three tabs to modify your chart.

Layout

Format

bt hoe bd |

The Design, Layout and Format tabs

.
.
.
.
.
.
.
.
.
.
.
.
.
.
0
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.



EXCEL WITH MS-EXCEL

1. From the Design tab, click the Change Chart Type command. A dialog box appears.

To Change the Chart Type:

i,

Chani Save As

Chart Type Template
Type

Row/Caolumn Data

= &

Switch Select

Data

Change Chart Type

Change to a different type of chart.

-

The Change Chart Type command

2. Select the desired chart type and click OK.

.

[ o

J

rChange Chart Type m-‘
A Templates 1 ] ] ] ] | .
S4) b aA] AA| b
|ﬁ Line Line I
& Pie 1 -1 ] p .1 . _ — =
= I | A ) s s
@. Area Pie Line with Markers B
i %Y (Scatter) p—— N NPT <l N
lis]  stock ':\__D |@ |@'® ':\__SQ |@d |@E
) Surface Bar
@ Doughnut ] - ] ] ] B [ e —
@2:‘3' |E |5 |E |% |§ |,g |§W

| ] (& [[o |[d][@1® |-
[ManageTemplahes... ] [ Set as Default Chart ]

Cancel

]

Selecting a chart type

To Switch Row and Column Data:

$600,000.00

Book Sales

% $500,000.00

'S 5400,000.00
[T
B $300,000.00

§ $200,000.00
(5 $100,000.00
$0.00

Fiction

Non-Fiction

02006
2007
u 2008
B 2009

02010

Book Sales, grouped by Fiction/Non-Fiction

Sometimes when you create a chart, the data may not be grouped the way you want it to be. In the clustered
column chart below, the Book Sales statistics are grouped by Fiction/Non-Fiction, with a column for each year.
However, you can also switch the row and column data so that the chart will group the statistics by year, with
columns for Fiction and Non-Fiction. In both cases, the chart contains the same data; it's just organized differently.

FINJOB
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h————————

1. Selectthe chart.

2. From the Design tab, select the Switch Row/Column command.

Insert Page Layout Formulas [

=
Switch Select E “ —Ilﬂ—lli—

Row/Column| Data
Data Chart Layc

Switch Row/Column

Swap the data over the axis. C

Data being charted on the X axis
will move to the ¥ axis and vice 8,1

versa.
9.9

The Switch Row/Column command

3. The chart will then readjust.

Book Sales

$600,000.00
E $500,000.00
'E $400,000.00
B 5300,000.00 — ——— —— —— —  HEFiction
ﬁ $200,000.00 —— —
{§ $100,000.00
$0.00

& Non-Fiction

2006 2007 2008 2009 2010

Book sales, grouped by year

EXCEL SHORTCUTS

CTRL+K Displays the Insert Hyperlink dialog box for new hyperlinks or the Edit Hyperlink dialog box
for selected existing hyperlinks.

CTRL+N Creates a new, blank workbook.
CTRL+O Displays the Open dialog box to open or find a file.

CTRL+SHIFT+0O selects all cells that contain comments.

CTRL+P Displays the Print dialog box.

CTRL+5HIFT+FP opens the Format Cells dialog box with the Font tab selected.

CTRL+R Uses the Fill Right commmand to copy the contents and format of the leftmost cell of a
selected range into the cells to the right.

CTRL+5S Saves the active file with its current file name, location, and file format.
CTRL+T Displays the Create Table dialog box.
CTEL+U Applies or removes underlining.

CTRL+5HIFT+U switches between expanding and collapsing of the formula bar.

FINJOB
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TRICKLE YOUR

I
I
L e e e e -
1. ASHOK LEYLAND-
For over six decades, they
have been moving people
and goods, touching you
across 50
AShOk Leyland countries worldwide. To-
day, Ashok Leyland are the
flagship of the Hinduja
Group, one of the largest commercial vehicle manufac-
turers in India with a turnover of US § 2.3 billion in

2012-13 having consistently delivered profits to our

and millions

stake-holders since inception.
Our buses safely carry 70 million passengers to their

destinations every day. Close to 700,000 of our vehi-
cles keep the wheels of economies turning and, as the
largest supplier of logistics vehicles to the Indian Army,
we play a critical role in keeping our borders safe.

¢ Founded— 07 September 1948
¢ Founder— Raghunandan Saran

¢ Headquarters— Chennai, Tamil Nadu, India

2. HTC -HTC Corpora-
tion is principally engaged
in the research, develop- "
ment and manufacturing Q a’uie'('l) brilliant
of smart handheld devices. '

The Company provides ’

touch phones, personal

digital assistant (PDA) phones, smart phones, Android
smart phones, Windows OS smart phones and panel
computers, among others. The Company offers its prod-
ucts under the brand name of HTC, including HTC But-
terfly series, Desire series, HTC One series, HTC Sen-
sation series, HTC Explorer series, HTC Rhyme series,
as well as HTC Radar series, among others. The Com-
pany distributes its products within domestic market and
to overseas markets.

¢ Founded— May 15, 1997
¢ Founders— H.T.Cho, Cher Wang

¢ Headquarter— Taoyuan City, Taiwan

Uchida, Goro Yoshida

STM, Japan

MIND

+3. MYSPACE
- Myspace LLC
operates a Web
site  to

o
4 myspace

create
private online community. It is an online service that
allows its members to set up personal profiles that can
be linked together through networks of friends. The
company enables its members to share photos, post
journals and comments, describe their interests, and
play social games. It also offers application program-
ming interfaces (API) that allow developers to leverage
public MySpace data and create applications to social-
ize content on and off MySpace. The company serves
matchmakers, families, business people and co-
workers, and classmates and study partners. It has users
in Australia, New Zealand, France, Germany, Ireland,
Italy, Japan, Mexico, Spain, Canada, the United King-
dom, and the United States.

¢ Founded— August 2003
¢ Founder— Tom Anderson, Chris DeWolfe

¢ Headquarters— Beverly Hills, CA, United States of
America

4. CANON - Canon India Pvt. Ltd. is a 100% subsidi-

ary of Canon Singapore Pte.Ltd; a world leader in im-

aging technologies. Canon today has offices spread
1100 people

across 10 cities in
140

India with an em-

comprehensive range of sophisticated and contempo-
rary digital imaging products in the country. These in-
clude digital copiers, multi-functional peripherals, fax-
machines, inkjet and laser printers, scanners, All-in-
ones, digital cameras, digital camcorders , dye sub pho-
to printers and semiconductors, card printers & cable
ID printers.

ployee strength of
over

and markets

¢ Founded— August 10, 1937, Tokyo, Japan

¢ Founder— Takeshi Mitarai, Takeo Maeda, Saburo

¢ Headquarters— Ota, Tokyo, TKY, Japan, Chichibu,



FINCOURSE

INTEREST RATE DERIVATIVES:
A BEGINNER’S MODULE

Interest rate risk management is becoming in-
creasingly important not just for the financial
sector, but for the household sectors as well. In-
terest rate derivative products are the primary
instruments available to manage such risks. In-
terest Rate Derivatives: A Beginner's Module
aims at creating a better understanding of the
concepts underlying the money market and giv-
ing insights into the motives of and operations
related to the trading of interest rate deriva-

tives."

Why should one take
this course?

To wunderstand the
concept of money mar-
ket

To wunderstand the
interest rate derivatives
as a risk management
tool

: Al

the Best

Who will benefit from this course?

ey market

Test details
Duration: 120 minutes

No. of questions: 60

Maximum marks: 100, Passing marks: 50
(50%); There is no negative marking in this
module.

Certificate validity: For successful candidates,
certificates are valid for 5 years from the test
date.

Test details

rect answers.

date.

FIMMDA-NSE DEBT MARKET
(BASIC) MODULE

This module explains in simple terms the
basic concepts of different types of debt in-
struments (G-secs, T-bills, CPs, Bonds and
CDs) and provides useful insights into the In-
dian debt market, its various components, the
trading mechanism of debt instruments in
stock exchanges, bond valuation and so on.

Why should one take this course?
To understand the fundamental features of

Who will benefit from this course?

debt instruments.

e To understand the trading of
the debt instruments on the
NSE-WDM Segment.

e To know the regulatory and
procedural aspects related to
debt market.

e To learn the concepts of
bond valuation, yield curve,
bootstrapping and duration.

e Students e Students

e Teachers e Teachers

e Employees of Banks, Insurance Companies" M e Debt Market Dealers

e Primary Dealers e Employees of BPO/IT Companies

» Employees of Brokers/Sub-Brokers e Anybody having interest in the Fixed In-
e Anybody having interest in the Indian mon- § come Market

Duration: 120 minutes

No. of questions: 60

Maximum marks: 100, Passing marks: 60
(60%); There is negative marking for incor-

Certificate validity: For successful candidates,
certificates are valid for 5 years from the test

FINJOB
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LIC AAO EXAM 2014

Life Insurance Corporation Assistant Administrative Officer Exam is conducted for the recruitment of Assistant Ad-
I ministrative Officer (Generalists/ Chartered Accountants/ Company Scretary/ Legal) in the LIC.

I LIC AAO Exam Eligibility
I Eligibility conditions for taking LIC AAO Exam are as follows:

Educational Qualification

For LIC AAO - Generalist— Candidates should possess a Bachelor/Master’s Degree from a UGC recognized Indian

I University with a minimum of 55% marks in the aggregate in either of the Degrees. However % is relaxed to 45% in
case of SC/ST candidates.

INOTE: If any university awards grades instead of marks, applicants should clearly mention the numerical
equivalent of the grades in terms of aggregrate marks and then write percentage scored out of aggregates marks.

| AGE

Candidates aspiring to take LIC AAO Exam should not be below 21 years of age and have not attained the age of 30
Years at the time of applying for the exam.

LIC AAO Exam Syllabus Apply Now
LIC AAO Exam Syllabus for objective test. k

1.Test of Reasoning: This test would include questions of both verbal and non-verbal type. The test may include
questions on analogies, similarities, differences, space visualization, problem-solving, analysis, judgment, decision-

making, visual memory, discrimination, observation, relationship concepts, arithmetical reasoning, verbal and figure
classification, arithmetical number series, etc.

The test will also include questions designed to test the candidate’s abilities to deal with abstract ideas and
symbols and their relationship, arithmetical computation and other analytical functions.

2. Test of English Language: This is a test to see how well you know English. English language ability would be

tested through questions on grammar, vocabulary, sentence completion, synonyms, antonyms, comprehension of a I
passage, etc. [

3. Test of Numerical Ability: Questions will be designed to test the ability of arithmetical computation of whole I
numbers, decimals and fractions and relationship between numbers. The questions would be based on arithmetical con- I
cept and relationship between numbers and not on complicated arithmetical computations.

4. Test of General Knowledge and General Awareness: The questions in Clerical Aptitude will be set to test the I .
candidate’s perceptual accuracy and aptitude. This is the ability to notice similarities and difference between the pairs 0

of names and numbers. Questions in Clerical Aptitude will also assess in addition to perceptual accuracy and aptitude, I
ability to handle office routine work like filing, abbreviating, indexing, etc.

LIC AAO Contact Details: LIC Customer Zone Mumbai

M/s Mayfair Housing Pvt.Ltd.9 Mayfair Meridian, Near St. Blaise Church, I
Caesar Road Andheri (W), Mumbai— 400058 I
Info Center number: 1251 or 022-26766221 I
Website: http://www.licindia.in/ I
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- DREAM JOB

Supply Chain Manager

technical background in engineering or computer
science
Job Description

As a supply chain manager, you'll be called upon to
purchase materials to support production. You'll analyze
and supervise the storage, use, and transport of materials
and inventory. You'll negotiate prices and delivery of
materials to produce cost savings and reduce lead times.
You'll assess the entire flow of goods and materials to
ensure efficient delivery, quality goods, and on-time
delivery of those goods.

manufacturing experience or knowledge

Career Advancement in Supply Chain Manage-
ment

There are many ways to begin your career in supply
chain management. An undergraduate degree will ena-
ble you to get a job with manufacturing companies and
begin gaining experience in supply chain management
straight out of college. Entry level positions in supply
chain management might include fleet management,
purchasing agent, buyer, shipping and receiving agent,
inventory analyst, routing manager, or customer service
rep. As you gain experience in your particular industry,
more opportunities for management will become availa-
ble to you. In addition to experience, you'll also
want to consider getting a masters in supply
chain management or an MBA in order to ad-
vance your career.

Some of the duties required of a supply chain manager
are:

® material resource planning
® enterprise resource planning
® audit and monitor suppliers

® source components under pres-

®  cstablish new suppliers

® monitor and develop existing
supply chain

® initiate and lead cost-saving
initiatives

Supply Chain Manager Jobs
negotiate and manage contracts Supply chain management jobs include:
® Dbuyer

® purchasing agent

Skills Needed to be an Supply Chain Manager
Technology plays a large part in your job as a supply
chain manager. In addition to your management skills,
you'll be expected to be able to use a computer, along

with various types of computer software to track materi-
als and goods.

e warehouse manager

® inventory manager

® production control analyst
® materials manager

In addition to technology, you'll need strong leadership ®  logistics manager

skills, critical thinking skills, analytical skills, commu-
nication skills and the ability to help train and develop
your staff. These are general skills you will acquire

through your education, training and work-related expe-
rience.

Supply Chain Manager Salary

One of the many questions people ask is: "How much
money will I make as an supply chain manager?" Ac-
cording to the Bureau of Labor Statistics Occupational
Outlook Handbook, median annual wages of purchas-
ing managers were $89,160 in 2008. The middle 50
percent earned between $67,370 and $115,830. The
lowest 10 percent earned less than $51,490, and the
highest 10 percent earned more than $142,550.

Because you'll be working in global environment, other

skills that will help you succeed as an supply chain
manager include:

® knowledge of a foreign language
Understanding of international standards
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1. Which among the following are the ‘Credit-Rating
Agencies’ of India ?

i. CRISIL ii. CARE
iii. ICRA iv. ONICRA
A.iand iii B.1,iiand iii

C.1,iiiand iv D. All of them

2. Consider the following Statements regarding ‘Take-Out
Financing’.

1. It is for infrastructure projects which have long gestation peri-
od.

ii. It helps to prevent any possible asset-liability mismatch.
Which of the above Statement (s) is/are correct ?
A.Only i B. Only ii

C. Both i and ii D. Neither i nor ii

3. The concept of ‘Universal Banking’ was implemented in
India on the recommendations of:

A. Abid Hussain Committee
B. R H Khan Committee
C. S Padmanabhan Committee

D. Y H Malegam Committee

ANSWERS OF NOW
IT’S YOUR TURN OF
FINJOB_17

WINNER OF FINJOB

1) Option-C
2) Option - A
3) Option-D

NOTE:- Send your solution of ‘Now it’s your turn-
1’ to the following email-id. The first two persons
who will give the correct solution, their name with
their photographs will be published in the next issue.

financeclub@its.edu.in

raviprasad@its.edu.in

N

Send us
suggestio

financeclub@its.edu.in
manjulamba@its.edu.in
raviprasad@its.edu.in
poojasingh.ds@its.edu.in

your feedback and
n at: EDITORS:
Ravi Prasad
Pooja Singh

Disclaimer:

FINVEST which symbolize finance and invest-
ment is a student managed club and it aims to

spread knowledge to all those who aspire to
learn the Nitti gritty of Finance. The uniqueness
about this club is its focus on practical aspects of]
finance and regular research by students which

keeps them updated with the changing scenario.

This newsletter is just a compilation of contents
of interview tips, fincourse, dream job, etc.
from various sources (newspapers, websites,
journals and magazines) and hence, no personal
analysis is being done by the members. Thus,
readers are expected to cross-check the facts
before relying upon them. Though much care
has been taken to present the facts without er-
ror, still if errors creep in, necessary feed backs
will always be welcomed. Editors would not be
responsible for any undertakings.
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